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Organisation and Conditions for Assessment 
 
 
The assessment is designed to test each candidate’s ability to apply knowledge and understanding and 
practical skills, developed through study of the Database Systems and Using Information Units. The 
mark out of 30 should be submitted to the SQA unscaled. This will be combined with the examination 
mark out of 70 to establish the candidate’s overall grade of award. This mark should also be used in 
preparation of estimate grades. 
 
The notional design length for the assessment is 8 - 10 hours. However, a candidate may be allowed 
longer than this if required.  
 
The assessment is to be undertaken under “open book” conditions, but under supervision by the tutor 
to ensure that the work submitted is the candidate’s own work. The tutor may give the candidate hints 
and/or help if requested. Any such help should be reflected in the marks awarded. Once the task has 
been completed and marked, it should not be returned to the candidate for further work. 
 
These instructions are designed to be used in conjunction with the data files provided with the 
electronic distribution of the task.  These can be downloaded from the SQA secure website. 
 
The files to be downloaded should include : 

• The 2009/2010 Intermediate 2 Information Systems Coursework Task  
• Chellow database 
• Background image for the graphical scene 
• Seven animal photographs 

 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 
prepared beforehand and provided to candidates by the centre. 
 
To facilitate this, database files for Microsoft Access and FileMaker Pro have been provided for this 
task.  The files contain or represent a number of tables with data entered.  The appropriate file(s) 
should be made available to the candidates. 
 
Centres using alternative relational database software can use the accompanying data files, which 
contain tab-delimited data required for the tables.  The centre should set up tables as appropriate 
within the database software and import the data provided.  The resulting database file should then be 
made available to the candidates. 
 
 



Notes 
 

• Candidates should be given a copy of the marking grid before starting the task so that 
they are aware of the mark distribution for each part. 

• Candidates should be given the Chellow database which contains the Animal table.  
During the Coursework, the candidate will have to create the Keeper table and link the 
two tables together.  It is essential that candidates use a relational database application for 
these tasks. 

• Task 3 asks candidates to print out a copy of the design of the Keeper table.  This is to 
provide evidence that the correct field types have been used and all necessary validation 
checks implemented.  The assessor should help candidates produce this printout without 
penalty. 
o In FileMaker Pro, to get a printout of the design, candidates should adhere to the 

following instructions. 
(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 
(2) Click on the Tables tab. 
(3) Click on the Keeper table and then choose Print. 

 
o In MS Access, to get a printout of the design, candidates should adhere to the 

following instructions.   
(1) Select the “Analyze” option from the Tools menu and then select the 

“Documenter” option from the sub-menu. 
(2) Click on the Keeper table and click on the Options button. 
(3) Make sure that the following options are checked/selected: 

• Include for Table 
 Properties 
 Relationships 

• Include for Fields 
 Names, Data Types, 

Sizes and Properties 
• Include for Indexes 

 Names and Fields 
 

(4) Click on OK 
(5) To display the design on screen and 

then Print. 
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• Task 6 asks candidates to print out a hardcopy of the relationships. 
 

o Printing Relationships in FileMaker Pro 
(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 
(2) Click on the Relationships tab then click on the Print button. 

 
o Printing Relationships in Access 

(1) Open the Relationships window. 
(2) Select the “Print Relationships” option from the File menu. 
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Chellow Zoological park aims to support wildlife conservation by providing a centre for breeding and 
conservation of animals.  School groups can visit the park to learn about the various animals and the 
reasons why many are now classed as endangered species. 
 
Chellow stores details about every type of animal in the park.  This information can be accessed 
during educational visits if required. 
 
A sample record is shown below. 
 
Animal Species Sumatran Tiger 
Class Mammal 
Continent of Origin Asia 
Average size (m) 1.5 
Lifespan (years) 15 
Main Colour Tan 
Favourite Food Deer 
Habitat Rain forest 
Endangered Yes 
Keeper ID KPR004 
 
Chellow employs a group of highly trained park keepers on either a full-time or part-time basis.  Each 
keeper has overall responsibility for specific species of animals only, although they can help out with 
all the animals in the park if required. 
 
The following information about each keeper has still to be added to the database. 
 
Field Name Field Type Field Size Primary Key Sample data 
Keeper ID Text 6 Yes KPR002 
Name Text 20 No J Thomas 
Gender Text 1 No M 
Date Employed Date  No 06/10/1985 
Phone Extension Text 3 No 655 
Employment Status Text 10 No full-time 
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What you have to do  
 

 Tasks Evidence Required 
1  Using a relational database application, create a table called 

Keeper that can be used to store information about each of the 
Park Keepers working at Chellow.  You should use the design 
shown on Page nine. 
 
(Note:  Your assessor will have provided you with the database 
file Chellow containing the Animal table.) 
 

 

a) Park Keepers are employed on a full-time or part-time basis.  
Alter the table so that the Employment Status field has a 
restricted choice validation check allowing only full-time or  
part-time to be entered. 
 

2 

b) Alter the table so that the Gender field has the appropriate 
restricted choice validation check applied. 
 

 

3  Print out a copy of your design for the Keeper table.  This 
should show the field types and validation checks. 
 
(If you are unsure how to do this, your assessor will be able to 
help you.) 
 

Printout of the Keeper 
table design showing 
field types and validation 
checks. 

4  Enter all the data into the Keeper table, taking care to ensure that 
the data is entered as shown below.  

 
 
 
Keeper ID Name Gender Date Employed Phone Extension Employment Status 
KPR001 M Tawse M 29/06/1995 654 full-time 
KPR002 J Thomas M 06/10/1985 655 full-time 
KPR003 M Jones F 14/04/2002 650 full-time 
KPR004 S Lee M 29/04/2002 653 part-time 
KPR005 S Khan M 08/01/2005 652 full-time 
KPR006 C Davies F 08/01/2005 651 full-time 
KPR007 M Stewart F 30/06/2007 650 part-time 
KPR008 A Brown M 12/05/2008 655 part-time 
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What you have to do (continued) 
 

 Tasks Evidence Required 
5  Create a simple report/layout to display the entire contents of the 

Keeper table. 
 
Produce a one page printout using this report/layout ensuring 
that all fieldnames can be clearly seen. 
 
Your name must be included in the report as a header or footer. 
 

Printout of the Keeper 
table report/layout. 

6  Link the Keeper table to the Animal table by using the Keeper 
ID field. 
 
Print out a copy of the relationship showing the link between the 
tables. 
 

Printout/screendump of 
the relationship window 
showing the link between 
the two tables. 

7  One of the Giraffes at Chellow has not been eating.  Produce a 
printout to display the Name and Phone Extension of the Keeper 
responsible for its care. 
 

Printout of keeper 
responsible in a report/ 
layout as specified. 

8  Produce a printout of a report/layout showing all mammals that 
originate from Africa. 
 
The printout should display the following fields only: 
 
Animal Species, Class, Continent of Origin, Endangered. 
 

Printout of all African 
mammals in a report/ 
layout as specified. 

9  Produce a printout of a report/layout to show all endangered 
animals at Chellow that have a lifespan of 10 years or more. 
 
The animals should be listed in order of lifespan starting with the 
longest lifespan.  If two or more animals have the same lifespan 
then they should be listed in alphabetical order of the Animal 
Species. 
 
The printout should display the relevant fields. 
 

Ordered printout of all 
endangered animals with 
a lifespan of 10 years or 
more in a report/layout as 
specified. 

 
Collect all printouts in the order they were asked for.  Ensure your name is printed on each report before 
handing to your assessor. 



The manager of Chellow has asked if you could create a simple presentation giving details on three 
animals found in the Park.  Slides on other animals can be added to this presentation at a later date and 
then used to help advertise the work of Chellow to other schools. 
 
The manager has photographs of the animals that you can edit to include in your presentation. 
 
   

 
He wants you to create an “animal scene” by 
“cutting out” the animal images from their own 
photographs and merging them onto the 
background image supplied. 
 
Each animal has to be resized and positioned. 
 
 
 
 
 
 
What you have to do (continued): 
 
 

 Tasks Evidence Required 
10  Using a suitable package create the “animal scene” shown above.  

(Note:  Your assessor will supply you with all photographs 
required.) 
 
You will need to: 
 

• load in the background image for the scene; 
• cut out the “sleeping lion and log”, resize and position as 

shown in the bottom left hand corner of the scene; 
• cut out the “young giraffe” and position eating the shrub; 
• cut out the “orangutan” and position hanging from the 

branch. 
 
Finally, check that the animal images are in proportion before 
saving as Scene. 
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The manager wants you to create a park logo using the Tiger 
photograph. 
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Each “cut out” tiger head has been resized and has had the 
transparency altered.  A pale cream background should be used.  An 
example is shown below. 
 

  
 
 
 
 
 
 
 
 
What you have to do (continued) 
 

 Tasks Evidence Required 
11  The manager has designed a park logo to be used in the 

presentation, as shown above. 
 

• Create the park logo using the “Tiger” photograph and 
drawing tools within the package.  Remember to: 
• use a pale cream background 
• resize each “cut out” tiger head 
• apply a different transparency to each tiger head 
• draw the border around the logo 
• rotate the text 

• Adjust the logo so that the dimensions are 4 cm in 
height and 6 cm in width. 

 
Save the completed file as “Logo”. 
 

 

 
The manager has provided you with more photographs.  These need to be edited before they can be 
used in the presentation. 
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What you have to do (continued): 
 

 Tasks Evidence Required 
12  Edit the photographs as stated below. 

 
• Resize the “red panda” photographs so that the width is 

8 cm and the height changes in proportion.  Flip the 
photograph so the red panda is facing to the left.  Save a 
copy. 

• Crop the “wolf” photograph to show the head and neck 
of one wolf only.  All parts of the wire fence should be 
removed and the dimensions of the cropped photograph 
should be 8 cm x 8 cm.  Save a copy. 

• Resize the “chimpanzee” photograph until the 
dimensions are 8 cm wide by height 10 cm.  Save a 
copy. 

 

 

 
Now that the graphics have been prepared, you are ready to create your four slide presentation.  To 
ensure consistency throughout, you should create and use a master slide with the park logo positioned 
in the top right hand corner. 
 
What you have to do (continued): 
 

 Tasks Evidence Required 
13  Create a master slide that you will use for all slides in the 

presentation.  You should ensure that: 
 

• the logo is imported and positioned in the top right hand 
corner; 

• the background colour for the page should be the same 
pale cream that was used in the logo. 

 

 

14  The first slide of the presentation has to include the animal scene 
and a title. 
 

• Import the animal scene picture and position in a central 
position on the slide. 

• Add the title “Chellow Zoological Park” at the top of the 
slide next to the logo. 

 

 

15  The second slide of the presentation has to display information 
about the red panda. 
 

• Import the edited red panda photograph and position on 
the right hand side of the slide. 

• Add the title “Red Panda” at the top left of the slide. 
• Extract five facts about the red panda from the Chellow 

database you used in the first task.  These facts should be 
entered in the left hand side of the slide opposite the 
photograph. 
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What you have to do (continued) 
 

 Tasks Evidence Required 
16  Repeat task 15 to create separate slides for both the wolf and 

chimpanzee. 
 

 

17  Add suitable navigational buttons to move forward and/or 
backwards through the presentation.  All buttons should have a 
consistent size, style and position throughout the presentation. 

 

 

18  Print out your presentation showing one slide per page. 
 

Printout of the 
presentation. 
 

(30 marks) 
 

Ensure your name is clearly visible on all printouts before handing to your assessor. 
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Marking Grid 
 
Name    Date    
 

Topic Possible
Marks 

Marks 
Gained Comment 

Creation of table 2,1,0   
Restricted choice 1,0   
Accurate data entry 1,0   
Display report 1,0   

Creation of 
Keeper Table 

Link Animal and Keeper tables 1,0   
 
Search Simple search  1,0   
 

Search correct 2,1,0   Complex 
Search Report layout 1,0   
 

Search correct 1,0   
Sort correct 2,1,0   

Complex Sort 
and Complex 
Search Report fields 1,0   
Printouts Name in header/footer 1,0   
 

Cut out images 2,1,0   Scene Images resized and positioned 1,0   
Tigers copied 1,0   Logo Logo size 1,0   
Red panda flipped 1,0   
Wolf cropped 1,0   Photos  
All images resized 1,0   

 
Presentation Master slide 1,0   
 Slide 1 1,0   
 Slide 2 1,0   
 Slide 3 1,0   
 Slide 4 1,0   
 Navigation 2,1,0   
  
Overall total 30   
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CONFIDENTIAL – not to be issued to candidates 
Detailed Marking Guidelines 
 
The following guidelines assume that all work was carried out by the candidate on their own (or with 
the assistance of open book materials).  Any assistance by the assessor should be reflected in a 
reduction of the number of marks awarded. 
 

Creation of table 2,1,0 Accurate creation of table fields and 
field types as specified without any help 
– 2 marks 
Some advice given – 1 mark 
Do not penalise if the date does not have 
double digits eg 06 
 

Restricted choice 1,0 Both Employment Status (full-time/part-
time) and Gender (M/F) set to restricted 
choice. 
 

Accurate data entry 1,0 Accurate inclusion of all keeper 
information – 1 mark 
>3 mistakes – 0 marks 
Do not penalise if capitals have not been 
used for Keeper ID and Employment 
Status as long as a consistent approach 
has been applied.  Names should have 
the appropriate capital letters. 
 

Display report 1,0 A one page report created/printed 
without any help.  All field names should 
be clearly visible – 1 mark. 
 

Creation of 
Keeper Table 

Link Animal and Keeper 
tables 

1,0 Tables linked without teacher help – 1 
mark. 

 

Simple Search 

Simple search 1,0 Correctly identifies S Lee as the 
responsible keeper. 
Printout of the layout/report – 1 mark. 
 

 
Search correct 2,1,0 Complex search for mammals 

originating in Africa – 2 marks. 
Only simple search – 1 mark. 
Otherwise 0 marks. 
 

Complex 
Search 

Layout/Report 1,0 Only specified fields are included and all 
are clearly visible – 1 mark. 
 

 



Scottish Qualifications Authority   20 
Coursework Task 

Intermediate 2 Information Systems  2009/2010 

 
Search correct 1,0 Complex search on Lifespan and 

Endangered – 1 mark. 
 

Sort correct 2,1,0 Complex sort on Lifespan descending 
and Animal Species ascending – 2 
marks. 
Simple sort – 1 mark. 
Otherwise – 0 marks. 
 

Complex Sort 
and Complex 
Search 

Report fields 1,0 Animal Species and Lifespan fields 
clearly visible on report – 1 mark. 
Do not penalise if Endangered field also 
included. 

 

Printouts 

Name in header/footer 1,0 A mark awarded if all report printouts 
have the pupils name added as a header 
or footer. 
 

 
Cut out images 2,1,0 Award 2 marks if the candidate has been 

able to cut out all animals correctly.  
Award 1 mark if any one animal has 
been cut from its background with no 
help. 
 Scene 

Images resized and 
positioned 

1,0 All three images should be correctly 
positioned and resized appropriately.  
Evidence is generated at printout of 
presentation. 
 

 
Tigers copied 1,0 Tiger head cut out and copied. 

The logo should display 4 heads, each 
increasing in size and transparency. 
 Logo Logo size 1,0 Approximate size accepted. 
Evidence generated at printout stage of 
presentation. 
 

 
Red Panda flipped 1,0 Photograph flipped to face left. 

 
Wolf cropped 1,0 Crop tool correctly used to remove wire 

fence and wolf body. 
 Photos 

All images resized 1,0 All images resized appropriately.  
Evidence generated at printout of 
presentation. 
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Master Slide 1,0 All slides should have the same colour 
and logo size/position. 
 

Slide 1 1,0 Correct title at the top of the slide and 
imported animal scene in the centre. 
 

Slide 2 1,0 Correct title at the top left of the slide, 
imported photograph on right and any 
five facts listed to the left of the slide. 
 

Slide 3 1,0 Correct title at the top left of the slide, 
imported photograph on right and any 
five facts listed to the left of the slide. 
 

Slide 4 1,0 Correct title at the top left of the slide, 
imported photograph on right and any 
five facts listed to the left of the slide. 
 

Presentation 
 

Navigation 2,1,0 1 mark for navigational buttons added 
which are consistent in size, colour and 
position. 
 
1 mark for working buttons which allow 
the users to move forwards and 
backwards through presentation as 
asked. 
 

 
 

 



Results 
 
Task 5 
 

 
 

ask 7 T
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Task 10 
Animal cut-outs 
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Completed scene 
 
 
Completed scene 
 

 
 
 
Task 11 
Logo size 4 cm x 6 cm 
 
 
 
 
 
 
 
 
 
 
 



 
Task 12 
Edited photographs 
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Task 18 
Completed Presentation 
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